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How To Use This Booklet
This booklet is filled with a variety of teaching tips to assist you, the 

instructor, with improving your course and helping your students 

get the most out of their course experience. Review the entire 

booklet or use the index on the next page to skip to the topics that 

are of most interest to you.

Here are some things to keep in mind:

• Some tips may work better for your course than others. 

• You may need to try some tips for a while to determine if they 

are working. 

• Begin by selecting a few quick and easy to implement tips then 

move on to tips that take more planning. 

• By gradually implementing these tips you limit the feeling of 

being overwhelmed by the changes and get to see incremental 

improvement in your course and students.

If you are unsure of which tips will help improve your course, 

the Office of Teaching and Learning offers personalized and 

departmental coaching. Our instructional coaches can help you 

review your course and design a plan that is manageable and 

specific to your course. 

Sincerely,

Dr. Stacy Duffield

Director  |  NDSU Office of Teaching & Learning
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These tips are grounded in the idea of retention and 
are methods, ideas, and actions you can incorporate 
into your class. These tips are taken from the sessions 
offered in the 2023 Teaching and Learning Conference. 
References and citations for any data or statistics listed 
here can be found in the videos posted on our YouTube 
channel at www.youtube.com/c/ndsuotl.

What is Retention?
Often times the definition for retention focuses on post-
course results as a way to quantify student numbers 
for retention. A shift from that is to a focus on the 
assignments in classes and how students can persist in 
a course. It is about student success in the present and 
how that carries students forward in their degree path 
and careers.

Mentorship
Increase mentorship opportunities. This establishes a 
community of peers and increases student confidence in 
the face of potential failure. This means students are more 
willing to ask questions and fail if they feel supported.

Why is Mentoring Important For Retention?
Three reasons are that it:
1. Enhances the overall experience for the student.
2. Improves class outcomes & productivity of students.
3. Establishes a community and network for students to 

work and thrive in.

Types of Mentoring
Hierarchical/Dyadic: Traditional mentoring from one 
mentor to multiple individuals.

Cyclic: Peer-to-peer mentoring where students work 
with and support each other.

Network: A newer model of mentoring where the student 
has multiple mentors from across different disciplines 
and levels.

*Cyclic and Network mentoring are shown as being more 
beneficial than the traditional model

Empathy
Teacher empathy, specifically, the degree to which you 
work to deeply understand and have care and concern 
for students, can positively impact learning, persistence, 
engagement, self-regulation, & post-graduation 
readiness.

Know Your Students
Getting to know students can help you better understand 
the issues that are prevalent in your classroom. One 
characteristic that is important to know is where students 
come from. Depending on their background, they might 
have issues and hurdles that keep them from succeeding 
and feeling a sense of belonging in the classroom. 
Understanding this and reaching out to students shows 
you care.

Be “That Person” For Students
Having one person that is truly listening and cares for 
a student can be a reason a student persists in their 
program. A student may be going through a hard time 
and associate this with their schooling at the university. 
Let them know those feelings are valid. 

Understand Student Intimidation
Students often are scared to ask questions and feel 
intimidated by you. This may stop them from asking 
an important question that will help them get through 
a problem they are having. Letting students know, 
through empathy, that questions are never trivial and it 
is important to ask them, can help students feel more at 
ease in the classroom.

Cautions For Using Empathy
1. Bias: People tend to favor those who are more like 

themselves.
2. Stress: It makes empathy more difficult.
3. Burnout: Important to maintain a self/other 

distinction when considering other people’s feelings 
and not feeling like you need to be empathetic 100% 
of the time.

4. Scope: Know what your scope of practice is. You are 
not a counselor, so make sure students know where 
to go on campus.

5. Power: Understand there is a lot of power between 
you and a student. Knowing student backgrounds is 
important but asking students to represent a whole 
cultural group may put too much pressure and create 
uncomfortable scenarios. 

Accessibility 
Accessibility goes beyond buildings and classrooms 
on campus with automatic doors and ramps to allow 
physical access. Students have different needs that can 
make it harder to achieve; they may  have visual, auditory, 
or physical impairments that may hinder them from 
completing or working on an assignment, participating 
in a group, or actively listening during class.
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Allow Students to Have a Part
Rather than you trying to build a static plan, students can 
be given a choice that lets them have an active part in 
moving their education forward. Using this method of 
instruction will not only help students achieve success 
and persist in their studies, it can also get them more 
involved and increase the quality of work they see as 
being more of their own design.

Remove Barriers
Learners come from different backgrounds and 
experiences that affect the way they learn. You may not 
see some of those barriers at the beginning of a course. 
An example of removing a barrier is, allowing a student 
who cannot type their essay to dictate it via Word or 
record their voice for the instructor to listen to. While this 
can be more work, it can also refresh a course in that it 
opens up new avenues for assignments to be completed.

The Why of Learning
If your course is not necessarily focused on building 
writing skills, students can be given multiple options for 
an assignment that does not have to be a typical essay 
or traditional research paper. Videos, magazine layouts, 
and podcasts are just some ways that assignments can 
engage in different ways and at different levels that still 
meet the why of an assignment.

The What of Learning
In what way is the information presented and accessed? 
Giving students options that go beyond traditional 
reading, like videos or PowerPoints with subtitles will 
allow students, who would otherwise not be able to 
engage with content, to be an active part in the class.

The How of Learning
Creating ways students can express themselves in their 
own unique way encourages students to be active with 
their coursework and feel attached to what they are 
being asked to do.

Guide to Accessibility
1. Make small manageable changes to your course 

and assignments. Start out with one assignment you 
tweak to slowly change your course and adapt it to 
the current cohort of students in your class.

2. Create and provide opportunities for feedback from 
students. This will help you identify issues and barriers 
in a class your students are grappling with. 

3. Create opportunities to overcome and break down 
issues and barriers. This way, students can get to their 
learning and progress forward in a class and help you 
move forward in the class curriculum. 

Community
Make connections to campus, programs, instructors 
and fellow students. It is important to help students feel 
like they are a part of a community. This was especially 
relevant during the COVID-19 pandemic. Friends 
can make this connection which can last through an 
undergraduate experience. You can make lasting impacts 
that keep students rooted on their career path at NDSU. 

How to Build Community 
Small things to help students feel at home at NDSU are 
to:

1. Call out student names and actively engage them in 
the classroom.

2. Have in-depth conversations with students as an 
advisor which makes them feel appreciated and 
taken care of.

3. Make it known that students can meet with you 
outside of class which gives students the confidence 
to seek help and make them feel appreciated in their 
college community when they are struggling.

4. Offer an introduction which can show students a 
side of you students would not otherwise see. This 
shows them an instructor trusts them and wants to 
welcome them into the NDSU community. 

Co-Create Class Expectations
Allow students the opportunity to understand and add 
to what the expectations of a class are. This gives them 
responsibility and helps them understand what their role 
as a student is and what the teacher’s role is.

Tools to help Create Community 
There are tools that can be used to facilitate group and 
individual work via an online platform. Consider learning 
more about these tools.
1. Flipgrid 
2. Google Jamboards
3. Nearpod

Connect Before Content
Allow students time to engage with one another before 
engaging with content. This builds a sense of community 
and helps them understand where they might want 
to go with their career as they share knowledge and 
experiences with fellow students.
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Set the Tone
What do you want the class to feel like? Students should 
feel engaged and excited if that is what you want for the 
tone of your classroom. Bring in activities for students to 
do, which is a great way to set this tone.

1. Check in Question:  Welcome students and build the 
classroom community by asking a casual question at 
the beginning of class. This is a great way to engage 
students right away and to get to know them better. 
E.g. What’s your favorite book? If you could remove 
one stressor from your life, what would it be?

2. Storytelling and Humor: Add these into a lecture or 
lesson to help students feel appreciated and engaged 
because it shows them you are human and want to 
get to know students. Getting too serious about a 
topic can serve as a disconnect with students. Not 
being afraid to laugh and share experiences is key to 
developing a community that works toward the goal 
of learning and growing. E.g. Connect a lecture with 
your past experience that has a funny element

3. Get Creative: Mix things up by being creative in 
the classroom. E.g. Self-care day: snacks, pajamas, 
blankets, etc.; Competition: Jeopardy, Family Feud, 
Board Games, Door Prizes; Setting: go outside, walk 
the halls; Materials: Use Crayons, Play-Doh, rocks.

 

Belonging
Opening a lecture with a big smile and projecting 
empathy awakens students and makes them feel alive 
and a part of a community that cares.

E.g. Ask yourself questions like “Do students feel as 
though they belong?”, “What is my part in that sense of 
belonging?”, and “What intentions and actions are being 
reflected in my classroom?” These all give you  a place to 
start when thinking about retention and how you can be 
an active part of influencing students in a positive way.
 

Showcase Optimism and Excitement
Hindering the building of community is the fact that 
some students feel and even know that some professors 
do not want to be in their classroom and that they would 
much rather be spending their time working on other 
things such as research. This makes it hard for students 
to feel that important connection to campus, especially 
when professors are blatant about how much they do 
not like teaching or dealing with undergraduates.
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Get NDSU Students Involved
NDSU students can share their experiences and passion 
for their program as a way to get prospective students 
talking and interested in NDSU programs. When NDSU 
students share details about their program in a way 
their advisor or instructor allows, this shows trust and 
responsibility, it also reaffirms the student’s place at 
NDSU as a member of our community.

Miscellaneuos Teaching Tips
Here are some tips every instructor should keep in mind!

Hybrid/Hyflex Courses
These courses can contribute to retention by providing 
students with flexible learning options and a personalized 
learning experience. There is more upfront preparation 
work for you for both of these options, but the pay off in 
time  saved from not having to catch students up is more 
than worth it. If students know they can access recorded 
lectures online they will not have to try and piece together 
what happened from readings and notes. Students who 
seek to gain the most out of courses like these are ones 
who may have other commitments or responsibilities 
that take them away from their coursework and being 
able to attend in-person at a regularly scheduled time.

Examples of students who need or would benefit from 
these courses are students who are parents, are sick, 
work full-time, have health issues or disabilities, lost a 
family member or are having a family emergency.

Ungrading 
When students focus on learning rather than solely 
the grades they retain information and get more value 
out of course content. This is especially true when 
considering that at the college level, their grade is their 
own responsibility. This means if there is an opportunity 
to guide from the sidelines and be solely a resource 
and mentor, those opportunities should be taken to 
encourage students to work and achieve through their 
own volition. Keeping this in mind, you should strive to 
provide extensive feedback to students.

Make Courses More Affordable  
If you are able, give students open and free resources  
online via NDSU licenses, this can be a great way to avoid 
students having to buy textbooks. This ensures students 
who can not afford a textbook stay in class, since the 
materials and resources are free and easily accessible.

Alternative Assessments
Traditional assessments may not accurately reflect the 
full range of knowledge and skills students bring to a 
course. That is where alternative assessments can step in.
 
1. Offer multiple attempts on tests. If the goal is for 

students to learn, giving the opportunity to correct 
mistakes will facilitate that learning. 

2. Reflect on work. By allowing students to reflect on 
their work and the progress of the course, students 
can go back and conceptualize their learning by 
ordering it and better understanding it as they seek 
to recall skills and knowledge learning. 

3. Declaration quizzes add another way to give students 
an alternative path via assessment. These quizzes 
give students responsibility and trust by having 
them answer on a quiz whether they completed 
certain tasks. If they did then they are responsible for 
knowing that content. 

Reasons to Look at the Syllabus
Give students a reason to look at the syllabus. Offer an 
assignment where students look for typos or a scavenger 
hunt. Students become familiar with content you  want 
them to be familiar with.

Use Teams
Teams can be used in the following ways:
1. Establish community in a virtual environment where 

students who are spread throughout campus can 
talk to each other quick and easy. 

2. Access a Resource Hub where resources can be 
posted for students to use whenever they need them.

3. Post workshop and webinar opportunities for 
students to access.

4. Provide networking and job opportunities for 
students so they can talk to professionals in the field 
and at the collegiate level. 

5. Investigate engagement data so these different 
benefits of Teams can be understood and adapted to 
better suit students and faculty.

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl/faculty_resources/getting_started

Be Honest About Courses
Generally, students do not understand what it really 
takes to teach a class at the undergraduate level. Being 
open with students without revealing too many personal 
or work-related details will key students in on just what 
it takes and will make them more sympathetic to your 
struggles and will encourage students to respect your 
time. This means if students know you cannot see them 
this week, they have an opportunity to plan ahead and be 
understanding of your busy schedule. 

Course Materials 
Make an easy to follow schedule and syllabus that are 
linked together with assignments makes the transition 
into the NDSU community easier since it gives them 
a clear structure to follow that guides them in a new 
environment that might seem daunting. Reassuring 
students with clear and concise materials like these 
opens up students by giving them a clear idea of what 
their place is in your classroom environment.

Checking in  
Whether a class is online or in person, it is important to 
check in with students with reminders about upcoming 
important dates and assignments. Showing students you 
are thinking about them and the class increases a sense 
of belonging since it shows students you are putting 
effort in to making sure students are taken care of. 

Student Careers
Laying out job prospects and opportunities for students 
in different programs is a great way to reassure students 
of the choices that they have made when considering 
their career after NDSU. Students will develop trust 
and respect for you if they feel that you have their best 
interests in mind.

Global Detail vs. Specific Detail
When you describe things in general to students and do 
not overwhelm them with minute details, students will 
get a good idea of what a program has to offer them. 
If they have further questions and are interested in a 
program, that is where you can step in and answer them.

Highlight Students and Alumni
Potential students want to see themselves in a program. 
Help them see this by highlighting successful students. 
This will attract students to a program that interests them 
and is a good fit for what they want out of a program.
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The following tips you can incorporate into your class are 
taken from the sessions offered in the 2022 Teaching and 
Learning Conference. References and citations for any 
data or statistics listed here can be found in the videos 
posted on our YouTube channel at www.youtube.com/c/
ndsuotl.

Videos in Classes
1. The four types of videos you can use in your course 

are: microvideos, tutorials, lectures, and screencasts. 
2. Adding video to a course increases engagement and 

is 83% more effective for retaining information.
3. Pre-recorded videos allows students to rewatch or 

prewatch videos to learn in their own way and time.
4. Offering videos reduces cognitive overload for your 

students.

Mental Models or Systems Models
5. Mental models or systems models are the top 

student-ranked most helpful technique or strategy, 
even when the instructor isn’t using it in their class.

6. Mental models help you evaluate the starting points 
of your students. If students can work backwards, 
forwards, and in all directions within a concept, then 
they have deep understanding.

7. Mental models work best over time and in groups. It 
is cognitively demanding to work alone.

Alternative Grading
8. Equitable grading strategies include: optional 

retakes, which can be split out by topic; flexible 
deadlines; limited grading of behaviors; equitable 
grading scales; and ungraded formative assessments.

9. Use homework and class time as opportunities for 
learning and feedback. Learning happens through 
mistakes.

10. Grades promote risk aversion and encourage 
performance over mastery. Grading everything 
equates to constant judging.

Adult Learners
11. In adult learning you are the facilitator who helps 

students navigate their learning.
12. You can promote independent learning in your 

class by slowly removing supports throughout the 
semester.

13. Connect adult student’s learning with life experiences.
14. Adult learners tend to learn more from their peers.
15. Practice the See, Do & Teach method with adult 

learners because they learn better when they have 
to teach someone else a concept.

Language Diversity
16. Recognize there is language diversity in every class; 

it may be through different languages, different 
regional or cultural dialects, or even familial usage 
of the language.

17. If personal interactions are pleasant, people are more 
willing to take on the cognitive load of listening to 
an individual with an accent. Facilitate pleasant 
interactions with your students.

18. Students have a higher cognitive load when they are 
worried about grammar. Consider not grading based 
on language and grammar usage when the concepts 
are the most important thing to learn (ex. discussion 
boards).

19. Grammar is the first thing to breakdown when 
learning new concepts.

20. Be specific about grammar expectations in your 
assignment rubrics.

Helping Students Write Better
21. Provide students with many examples of good 

writing in your field.
22. Instruct students on the writing process, which 

is: planning, drafting, sharing, evaluating, revising, 
editing, and publishing. Many students do not know 
the process.

23. Hold group discussions to give good quality feedback 
and to discuss their struggles.

24. Peer editing helps students analyze both good work 
and their own work.

Student Wellness
25. On your syllabus include on-campus resources 

for wellness and a statement of wellness. Assign 
wellness-related tasks like writing a paper on their 
wellness plan or touring a wellness resource.

26. In class, use clickers to allow students to anonymously 
gauge how they are feeling today.

27. Be a wellness role model for your students.
28. Offer flexible homework submissions (ex. videos, 

creative writing, etc.), adjust your deadlines to 
promote better sleep for your students, and 
consider offering extra credit or make-up points for 
participating in wellness activities.

Racial Achievement Gap
29. If you can adjust a student’s mindset you can help 

them have better outcomes.
30. Racial achievement gap was two times higher in 

classes with instructors who have fixed mindsets.
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For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl

31. Instructors with a growth mindset tend to include 
why a student is learning a concept in their class.

32. Cognitive resources are split when a student is actively 
trying to avoid being stereotyped, which lowers their 
performance.

33. Active learning strategies have a disparately positive 
result for students of color.

Learning By Doing
34. Students need to see that you aren’t perfect, and you 

deal with the same issues they do.
35. Give students many examples of why they need the 

skills you are teaching them.
36. Bring in concepts that fit with the data they are 

working with.
37. Teach your students to self teach. Google is your best 

friend.

High & Low Technology for Rapid Feedback
38. Some high-tech tools that are fast and provide quick 

formative assessments include: clickers, Google 
products, diagrams.net, free polling software, Zoom 
chat, and Zoom polls.

39. A useful, low-tech tool for formative assessment is 
a color-coded card that corresponds to the answer 
choices. Students then raise their cards with their 
answer.

40. Don’t be afraid to improvise in your class.
41. Share the polls with your students and why you are 

doing them.
42. Let your students know it is okay to say, “I don’t know.”

Supporting Students in a Pandemic of Grief
43. Allow students space to share their story or speak 

about grief in class. Consider using a Blob Tree image 
to facilitate discussion.

44. Behaviors students might exhibit in class might reflect 
the stages of grief; be aware of the stages of grief.

45. Sometimes what we see as disengagement from our 
students is actually a grief response.

46. When a student is going through something big, 
they may tend to be more forgetful, have difficulty 
concentrating, and difficulty making decisions 
because our brains can only process so much.

47. Validate your student’s losses.

Flipgrid
48. Flipgrid is a free educational platform.
49. You can use Flipgrid to: encourage effective learning 

strategies, provide personal and direct feedback, and 
foster a sense of community.

50. Ask your students to connect a concept to something 
in their life, have them post a video discussing it.

51. Use video to provide feedback to students so they can 
hear your voice, inflection, tone, and see your non-
verbal cues. It is less formal and faster than written 
feedback.

Trauma Informed Practices (TIP)
52. If stress is detected in your learning environment, 

learning will be more difficult for those impacted by 
trauma. If you, as the instructor, project stress your 
students can pick that up.

53. Individuals who have endured trauma have a harder 
time switching out of fight or flight mode and back 
into a more productive way of thinking.

54. Some of these everyday learning experiences can 
activate a trauma response: lack of choice, team 
building, unclear rules, ambiguity, and forced sharing. 

55. Conduct a trauma walk through on your classes. 
There are formal assessment tools available to help 
with this.

56. Assess your teaching through these six key principles: 
safety; trustworthiness and transparency; peer 
support; collaboration and mutuality; empowerment, 
voice, and choice; and recognizing cultural, historical, 
and gender issues.

57. You might see the following responses in a student 
impacted by trauma who is currently in a fight or 
flight mode: difficulty focusing, attending, retaining, 
or recalling information; absenteeism; fear of risks; 
trouble with emotional regulation; anxiety about 
deadlines or coursework; withdrawl or isolation; 
unhealthy relationships; or nothing at all. Trauma 
informed practices is based in equity, meaning you 
customize the tools for the individual’s strengths. 
Don’t assume that a person has had a trauma, but 
know it is a possibility.



For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl
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The following tips, you can incorporate into your class,  
are taken from the sessions offered in the 2021 Teaching 
and Learning Conference. References and citations for 
any data or statistics listed here can be found in the 
videos posted on our YouTube channel at www.youtube.
com/c/ndsuotl.

Teach With Empathy (Not Sympathy)
Sympathy is not empathy. Sympathy is a feeling of pity and 
sorrow for someone else’s misfortune. Empathy is a way 
of connecting with people that shows you understand 
they are experiencing something meaningful- even 
though you may not understand exactly how it feels 
for them. Instructors high in teacher empathy do not 
lower standards; they identify and remove obstacles to 
learning.

Get To Know Your Students
In order to make an impact on students’ lives you need 
to understand them first. You can do this by deploying 
a student survey. You can ask students to write a “This 
I believe…” essay. You could also ask students to create 
their reflexivity statement.

Adopt A Growth Mindset
Help students adopt a growth mindset. This is the belief 
that I will need to persevere through difficulty before I 
succeed. The desire to work hard consistently with the 
courage to ask questions when confused.

Inclusive Course Policies
Design course policies that reflect a deep understanding 
of students’ personal and social situations – Incorporate 
course policies for greater inclusion and equity. Inclusive 
and equitable teaching provides opportunities for 
success for students from ALL identities. 

Build Trust With Your Students
Trust your students, assume they are trying their best. 
Recognize each student has different pressures on 
their time and energy. Help your students understand 
the learning goals. Tell them the “why” behind each 
assessment.

Collaborate With Students
Let students lead the learning process by collaborating 
with students to discuss progress on meeting their 
learning goals. Invite students to set personal learning 
goals within the domains of the course. Enable students 
to complete self evaluations and reflections across the 
semester. You might also reconsider strict deadlines.

Ease Asynchronous Learning
For asynchronous learning, make it easy for students 
to access materials – make it obvious where to start, 
mention clear, attainable goals and objectives. Mention 
the standard methods of submitting assignments.

Create An Organized Course
Create streamlined content for students to follow. 
An organized course is the key to student success. An 
unorganized course will cause delay in assignments 
being completed. Make Blackboard navigation easier. 
Allow for students to have easy, accessible, and organized 
materials on Blackboard.

Be Flexible With Your Students
Flexibility improves the learning experience of your 
students. Post notes, assignments, class materials at least 
5-7 days before deadlines. Provide structure by having 
assignment deadlines but have a flexible deadline policy. 
Allowing students to resubmit assignments or retake 
tests increases their motivation to learn.

Create An Engaging Learning Environment
Using a variety of ways to display and provide 
information is optimal for desired learning outcomes. 
Offering opportunities for choice and autonomy is one 
way you can create a more meaningful and engaging 
learning environment. Often students do not understand 
or appreciate the reason why what they are learning is 
important. Establishing the “why” behind what you teach 
will help your students see relevance and value in the 
material.

Use Creative Ways To Engage Students
Instructors can use creative ways to engage students. 
For example, Dr. Sylvio May presents finger puppets 
alongside his presentations about the specific scientist 
being discussed. Dr. Beena Ajmera created themed weeks 
for students to create backgrounds on Zoom to fit into 
the themes. Dr. Jenny Linker shared how she used Swivel 
software in the classes she holds in the gymnasium. The 
camera follows the professor and can be integrated into 
Zoom.
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LITTLE HINTS 
To Use With Your 

STUDENTS
Advising Edition

Providing little hints throughout the semester can help 
your students succeed. Use the content on this printable 
to provide a new tip for your students each week during 
your regular class session. Some tips have suggestions 
for you in parenthesis. You may use this list as written 
or you may pick and choose which tips to use based on 
your specific class demographics.

Week 1
Ensure your class registration is final, inquire about wait 
lists if needed, and introduce yourself to your academic 
advisor.

Week 2
Identify the office hours on your syllabi for each class 
and keep the list handy for when you need them!

Week 3
Find a good study space on campus that works for 
you. Spaces include your residence hall/apartment, the 
library, and outside some classrooms. There are a lot of 
great spaces around campus!

Week 4
Check on your current grade and attendance for each 
class. If you missed assignments or quizzes can you make 
them up? What else can you do to get back on track?

Week 5
Have you sent or received any emails from your advisor 
yet? If not, now is a great time to have an initial meeting 
to start to discuss your interests in the major.

Week 6
Learn about academic organizations to get involved with 
for your major. (Highlight a few that are relevant to your 
department or program.)

Week 7
Browse your major department’s webpage – view faculty 
bios and learn about their research interests. Can you 
get involved with their research or other opportunities? 
(Share a few minutes about something you are working 
on and how undergrads have been or could get involved.)

Week 8
Midterm of the semester – check in with faculty members 
again and prepare for midterms. Look ahead for any big 
final projects.

Week 9
Take a look at your Degree Map and familiarize yourself 
with the academic requirements for your major. You can 
plan a tentative list of classes to discuss with your advisor. 
(https://ndsudm.civitaslearning.com/)

Week 10
Think about Spring registration and meet with your 
academic advisor.

Week 11
Take note of your current grade in the class and remaining 
work. Do you need to consider a withdraw from the 
course? Discuss options with your instructor and advisor. 
(Put a note on the syllabus/weekly tip that you are willing 
and open to chat. Students may need the reminder it’s 
okay to visit.)

Week 12
Check your Campus Connection account for any holds 
that may prevent timely registration for next semester. 
(https://www.ndsu.edu/onestop/holds)

Week 13
Register for classes as close to your assigned registration 
time for best availability of classes and class times. 
(https://www.ndsu.edu/onestop/registration)

Week 14
Put together a study plan for final exams.

Week 15
Make use of any study sessions offered. (List study 
sessions for your class.)

Week 16
Reflect on how the semester went and what adjustments 
you might want to make.

Inspired by an NDSU OTL We Learn Together Blog post titled, Being 
First, in which a student named Hajira greatly benefitted from the little 
hints her instructor gave.

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl/faculty_resources/getting_started

https://adfs.ad.ndus.edu/adfs/ls/IdpInitiatedSignOn.aspx?SAMLRequest=fZHLboMwEEXX%2FQvkPS9DXqOAlCqLIrVK1KAuuqkm2EkswUAZu8rnF0gX6SbeeXzm3pnrNWNTd7Bx9kLv%2Bttptt61qYlhesiE6wlaZMNA2GgGW8Fh8%2FYKMoig61vbVm0tvOE8bYdeQ2hNS5m4WNsxhCGqEweoAlKOA63cVAhrDgvVFWSsQavVwZxpRwFyd52kim0mvmJ5Ws2Wq%2FQYJ3Gq9Cw9Latokc7nx1TPkkVyI5mdLogtks2EjKT0o5UvZSklRDHE8nPC9n%2BDPhtShs6PtzreIIaXstz7%2B92hFN6H7nnaawBEvh6zgcm7v0vrsSwy634MR%2BQjhkPiEVTmx1jkWmNPgyeQYqcaf1Rbh3cu%2Be32%2F6PyXw%3D%3D&RelayState=8w06aiCj3_dbsXDSLNaLZpC-TYovdB2F
https://ndsudm.civitaslearning.com/
https://www.ndsu.edu/onestop/holds


CREATING 
ACCESSIBLE
DOCUMENTS
Email - Microsoft Outlook 

Use this list to check for common accessibility issues in Emails. 
This document specifically addresses Microsoft Outlook as that 
is the campus-supported software. Microsoft offers step-by-
step instructions on how to fix accessibility issues, and further 
explanation on why these are important. Use this quick tips 
sheet to meet the basic accessibility requirements.

Include Alt Text With All Visuals
Why: For screen reader users, alternative text helps to 
communicate what is important in images and other 
visuals. Alt text helps people who can’t see the screen to 
understand what’s important in images and other visuals. 

 » How: Control + Click the image or object > Edit alt 
text > Type 1-2 sentences in the text box to describe 
the object and its context.

Do Not Use Infographics in Place of Text 
Why: Screen readers cannot read images or infographics 
without alt text. Unless your image has alt text, do not send a 
.jpg or PDF as the only item in an email. Another option would 
be to add the text in the image or infographic as text in your 
email.

Add Meaningful Hyperlink Text
Why: People who use screen readers sometimes scan a list of 
links. Links should convey clear and accurate information about 
the destination. For example, instead of linking to the text Click 
here, include the full title of the destination page. 

 » How: Click on the insert link option on the bottom toolbar 
> Insert Link > Write the information about the destination 
in the description > Write the URL in the web address box

Don’t Use Color To Convey Information
Why: People who are blind, have low vision, or are 
colorblind might miss out on the meaning conveyed by 
particular colors.

 » How: Add an underline to color-coded hyperlink 
text so people who are colorblind know the text is 
linked even if they can’t see the color. For headings, 
consider adding bold or using a larger font.

Use Good Contrast 
Why: High contrast text is easier to read for sighted and 
low sighted individuals. If you use black or gray text in your 
emails, use at least 70% tint for your gray colors. When 
using color, choose dark colors on a light background. If 
you struggle to read the email, so will your readers.

Add Table Header And Column Information
Why: To keep track of their location in a table, screen 
readers count table cells and use header information 
to identify rows and columns. If a table is nested within 
another table or if a cell is merged or split, the screen 
reader loses count and can’t provide useful information 
about the table. Blank cells in a table could also mislead 
someone using a screen reader into thinking that there is 
nothing more in the table.

Use A Larger Font Size
Why: People who have dyslexia describe seeing text 
“swim together” on a page (the compressing of one line 
of text into the line below). They often see text merge 
or distort. To reduce their reading load use a larger font 
size, 11pt or larger.

 » How: Click on the font size bar > Select a font size of 
11pt or larger

Include Sufficient White Space
Why: In order to reduce workload for individuals with 
dyslexia, make sure there is ample white space between 
sentences and paragraphs

Request Accessible Emails
Why: If you wish to make sure you receive accessible 
emails, you can let the sender know that you prefer to 
receive accessible content.

 » How: Click the settings icon on your Outlook on the 
web > In the search bar type “Accessible Content” > 
Click on Accessible Content > Select the “Ask senders 
to send content that’s accessible” checkbox > Click 
save

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl/faculty_resources/course_design/course_materials

CREATING 
ACCESSIBLE
DOCUMENTS
Microsoft Word

Use this list to check for common accessibility issues 
in Microsoft Word documents. Microsoft offers in-
depth information on the use of its accessibility checker 
feature as well as step-by-step instructions on how to fix 
accessibility issues, and further explanation on why these 
are important.

Insert Document Titles
Why: Document titles provide information on what a 
screen reader is reading.

 » How: File menu > Properties > Summary > Title > 
Enter descriptive title for your document.

Use Alt Text For All Images
Why: Screen readers cannot read photos without alt text 
or descriptions. Individuals may miss or wonder if they 
have missed important information.

 » How: Click image > Picture Format menu > Format 
Pane > Layout & Properties ( ) > Alt text > Simple 
images, fill in title, Ex: John Doe; Images with words 
or diagrams, fill in title and description box with 
information explaining image significance or what 
text in the image says.

Use Table Headers
Why: Table headers explain the information in columns 
a screen reader reads. Without table headers, a screen 
reader reads, “Accessibility issues, 10, 14, 3” versus “Book 
title accessibility issues, Page 10, Total pages 14, Number 
of follow up questions 3.” 

 » How: Insert menu > Table > Choose columns & rows 
+ 1 extra row > Table Design menu > Ensure Header 
Row box is checked > Type column headers in first 
row of table

Use Headings And Sub-Headings
Why: Provides a logical reading order for screen readers. 
Saves time with accessibility when exporting to a PDF.

 » How: References menu > Add Text > Highlight text to 
classify as heading or sub-heading > Choose Level 1, 
then Level 2, then Level 3 as needed. 

Use Descriptive Hyperlinks
Why: Descriptive hyperlinks enable users to know what 
information they will receive if they click the link. A 
screen reader reads a link as, “link click here” versus “link 
how to fix accessibility issues.”

 » How: Write a description of what the link provides > 
Highlight link text > Insert menu > Link > Click web or 
email option > Insert web or email address

Use Good Contrast 
Why: High contrast text is easier to read for sighted and 
low sighted individuals. If the document is black and 
white, use 70% tint for your gray/black colors. When 
using color, choose dark colors on a light background or 
light colors on a dark background. If you struggle to read 
the document, so will your readers.

 » How: Font color menu ( ) > Hover cursor over gray/
black color choice > Choose a color that says “lighter 
25%” or a lesser percentage. “Lighter 25%” means the 
tint is 75%. If you use anything more than 25% lighter, 
your document will be flagged for contrast issues.

Use Multiple Ways To Identify Information
Why: If color is the only way to differentiate between 
items, low sighted, color blind, and sighted individuals 
may struggle to see the difference between each color. 
Variations in colors used by computer monitors and 
printers can be significant; and, when printed in black 
and white, color variation and meaning are lost.

 » How: You can use color to differentiate but offer 
another differentiation tool. This could be numbers, 
letters, or other characters.

Watch For Extra Spaces After Words
Why: Extra spaces after words or sentences are read by a 
screen reader as either “space” or “blank.” Neither convey 
meaning and can contribute to confusion.

 » How: Make an effort to NOT add spaces after 
sentences; and, add, “check for extra spaces,” to 
your editing process. Place cursor at the end of each 
paragraph, use the right arrow key to see if there are 
extra spaces, and delete any you find. 

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl/faculty_resources/course_design/course_materials

https://support.microsoft.com/en-us/office/make-your-outlook-email-accessible-to-people-with-disabilities-71ce71f4-7b15-4b7a-a2e3-cf91721bbacb#PickTab=Windows
www.ndsu.edu/otl/faculty_resources/course_design/course_materials
https://support.microsoft.com/en-us/office/rules-for-the-accessibility-checker-651e08f2-0fc3-4e10-aaca-74b4a67101c1
https://support.microsoft.com/en-us/office/rules-for-the-accessibility-checker-651e08f2-0fc3-4e10-aaca-74b4a67101c1
https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d
https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d
www.ndsu.edu/otl/faculty_resources/course_design/course_materials


CREATING 
ACCESSIBLE
DOCUMENTS
Microsoft PowerPoint

Use this list to check for common accessibility issues in 
Microsoft Powerpoint presentations. Microsoft offers in-depth 
information on the use of its accessibility checker feature as 
well as step-by-step instructions on how to fix accessibility 
issues, and further explanation on why these are important.

Use Unique Slide Titles
Why: Individuals using a screen reader skim through 
slide titles to navigate; they quickly scan slide titles and 
go right to the slide they want. Using unique slide titles 
allows them to clearly understand which slide they are on. 
Avoid using the same title for slides that have spill-over 
information, consider including additional information 
such as ‘Slide Title 1 of 2’.

Use Built-in Slide Templates
Why: Built-in slide layout templates are designed so the 
reading order is the same for people with vision and for 
people who use screen readers. 

 » How: Design menu > Select a built-in slide template.

Add Alt Text To All Images, Objects and Tables
Why: For screen reader users, alternative text helps to 
communicate what is important in images and other 
visuals. Alt text provides a textual alternative to non-text 
content.

 » How: Right click the image or object > Format picture/
object > Size & Properties ( ) in the left pane > Alt text > 
fill in title and description explaining the object or image.

Use Table Headers
Why: Table headers explain the information in columns a 
screen reader reads. Without table headers, a screen reader 
would not be able to correctly read the table. 

 » How: Insert menu > Table > Choose columns & rows + 1 
extra row > Table Design menu > Ensure Header Row box is 
checked > Type column headers in first row of table

Set Reading Order Of Slide Contents
Why: Screen readers read the elements in the order they 
were added to the slide, which might be different from the 
order in which things appear. It’s important to check the 
reading order by using the Selection Pane. The reading 
order in the Selection Pane should be arranged from the 
bottom up. The title should be at the very bottom with 
subsequent content above it.

 » How: Home > Arrange > Selection Pane > Arrange the 
reading order by dragging the objects on the right pane.

Use Descriptive Hyperlinks
Why: Descriptive hyperlinks enable users to know what 
information they will receive if they click the link. A 
screen reader reads a link as, “link click here” versus “link 
how to fix accessibility issues.”

 » How: Write a description of what the link provides > 
Highlight link text > Insert menu > Link > Click web or email 
option > Insert web or email address

Use Good Contrast 
Why: High contrast text is easier to read for sighted and 
low sighted individuals. If the document is black and 
white, use at least 70% tint for your gray colors. When 
using color, choose dark colors on a light background or 
light colors on a dark background. If you struggle to read 
the document, so will your readers.

 » How: Font color menu ( ) > Hover cursor over gray/
black color choice > Choose a color that says “lighter 25%” 
or a lesser percentage. “Lighter 25%” means the tint is 75%. 
If you use anything more than 25% lighter, your document 
will be flagged for contrast issues.

Use Multiple Ways To Identify Information
Why: If color is the only way to differentiate between 
items, low sighted, color blind, and sighted individuals 
may struggle to see the difference between each color. 
Variations in colors used by computer monitors and 
printers can be significant; and, when printed in black 
and white, color variation and meaning are lost.

 » How: You can use color to differentiate but offer another 
differentiation tool. This could be numbers, letters, or 
other characters.

Avoid Excess Animation
Why: People can get vertigo or be sensitive to moving 
or flashing images. Because of this, animation should be 
kept to a minimum. Strobing or rapidly moving images 
should be avoided, as this can make certain viewers sick 
or cause a seizure.

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl/faculty_resources/course_design/course_materials

CREATING 
ACCESSIBLE
DOCUMENTS
PDFs

Use this list to make sure the final PDF document is accessible 
when converting documents into a PDF file. The first and most 
important thing is to ensure the document you are converting 
follows all accessibiity standards. Once you have made sure 
there are no accessibility issues, follow these steps. The most 
common adjustments will be discussed below.

Save A Document As PDF
Why:. In order to preserve the accessibility changes made in 
the PowerPoint or Word document, the PDF conversion has to 
be done in a specific way.

 » How(For Mac): Click file > Save As > Select PDF from the 
file format dropdown > In Microsoft word check the box 
labeled “Best for electronic distribution and accessibility” 
> Save.

 » How(For Windows): Click file > Save As > Select PDF 
from the file format dropdown > Options > In Microsoft 
word check the box labeled “Document structure tags for 
accessibility” > Ok > Click save.

Use The Accessibility Checker Feature
Why: The Accessibility Checker feature will automatically check 
to see if there are any accessibility errors. If you have used the 
accessibility checker features in other platforms, you will have 
minimal adjustments to make in a PDF. 

 » How:  Click Tools > Accessibility > Accessibility Checker > 
Start checking > The system will automatically check for 
accessibility issues and show if there are any issues. To 
resolve issues simply Right Click on the unresolved issue 
> Click Fix.

Add A Title To The Document
Why: Having a document title makes it easier for someone using 
a screen reader to know what document they are listening to. If 
you missed this, you can still do this during the PDF accessibility 
check.

 » How: Click Document > Title > Control + Click > Fix > 
Uncheck “Leave as is” and change document title.

Set The Appropriate Reading Language
Why: An appropriate language must be selected in the PDF 
properties so that the screen reader knows what language to 
read in. 

 » How: Click File > Properties > Advanced > Reading 
Options > Select “English” or the appropriate language the 
document is written in. 

Make Sure The Document Uses High Contrast
Why: Make sure that the document is in high contrast so 
that the text is easier to read for sighted and low sighted 
individuals. This means dark text on a light background or 
light text on a dark background.

 » How(For Mac): Open File in Adobe Acrobat DC > Click 
Acrobat Pro DC > Preferences > Select Accessibility > 
Check the “Replace Document Colors” box > Select “Use 
High-Contrast Colors“ > From the dropdown list select 
“black text on white”.

 » How(For Windows): Open File in Adobe Acrobat DC > 
Click Edit > Preferences > Select Accessibility > Check 
the “Replace Document Colors” box > Select “Use High-
Contrast Colors“ > From the dropdown list select “black 
text on white”.

Set The Reading Order
Why: Since the reading order is unique to each document, 
the accessibility checker is unable to fully check the reading 
order. Double check that the PDF is reading the document in 
the intended order. 

 » How: Click Tools > Accessibility > Accessibility Checker 
> Reading Order > Show Order Panel > Review the 
numerical order for each page. For items a screen reader 
would not read, click + ctrl or right click on the number of 
the item in the side panel. From the menu, choose what 
type of content it is. “Tag as Decorative/Background” will 
indicate that it is not content that adds meaning to the 
document.

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl/faculty_resources/course_design/course_materials

https://support.microsoft.com/en-us/office/rules-for-the-accessibility-checker-651e08f2-0fc3-4e10-aaca-74b4a67101c1
https://support.microsoft.com/en-us/office/make-your-powerpoint-presentations-accessible-to-people-with-disabilities-6f7772b2-2f33-4bd2-8ca7-dae3b2b3ef25
https://support.microsoft.com/en-us/office/make-your-powerpoint-presentations-accessible-to-people-with-disabilities-6f7772b2-2f33-4bd2-8ca7-dae3b2b3ef25
www.ndsu.edu/otl/faculty_resources/course_design/course_materials
www.ndsu.edu/otl/faculty_resources/course_design/course_materials


LITTLE 
HINTS FOR 
INSTRUCTORS

Get off to a great start and keep the momentum going 

with these helpful hints for your classes this semester.

 Week 1
TIP 1: Check on your books and materials in the NDSU 
Bookstore to ensure the books are in and there are 
adequate numbers for your course enrollment. 
TIP 2: Provide a tour for your students in Blackboard 
to show them how you will use it and where to find 
important items. You can do this during a class session, 
record a video and post it in Blackboard, or provide a 
written guide.

   Week 2
Administer a survey to get to know your students better 
and support their learning. A survey template is available 
in the Qualtrics NDSU Library. See sample items. 
(https://drive.google.com/file/d/1RmqzI9yZWTOz2mMqzwiE4K31LL-kcwrm/view)

   Week 3
Help your students get to know one another by using 
group activities to learn the content and allotting the 
first minute or two for introductions and sharing. 

   Week 4
Your students will learn better and are more likely to 
retain the information when they can experience the 
content by seeing, hearing, saying, and writing. We often 
only plan for the seeing and hearing. Include activities 
during class that allow students to write and speak about 
the content.

   Week 5
Learn more about the Student Course Experience 
Surveys your students will be asked to complete at the 
end of the semester. 
(https://www.ndsu.edu/gdc/qualtrics/student_rating_of_instruction_srois/)

   Week 6
Spring semester course materials orders are due 
November 1st. The NDSU Bookstore is required by law 
to list all course materials for all NDSU courses.

   Week 7
Prepare and administer a midterm feedback questionnaire 
in your classes. A survey template is available in the 
Qualtrics NDSU Library. It can be as simple as this.
(https://drive.google.com/file/d/1EYWHdHSzNE9PTvXbnxo19swOD3Yud69d/view)

   Week 8
Share the midterm feedback and how you will address 
any concerns with your students so they know you are 
listening.

   Week 9
Students will learn more when they receive narrative 
feedback that tells them what they are doing well and 
how they can improve.

   Week 10
Want help building your final assessment? Consultants 
in the Office of Teaching and Learning can help, whether 
it’s a traditional exam or a performance assessment. 

   Week 11
Keep notes about what is going well with your class and 
what you want to change for next time. We think we will 
remember, but when it gets busy, it’s easy to forget. 

   Week 12
Have you kept your grade center up to date?  If not, now’s 
a good time to catch up and communicate with students 
to let them know where they are at in the class. 

   Week 13
Sign up for Peer Teaching Partnership for the next 
semester. Select either the formal or informal track. 
Learn more.   (www.ndsu.edu/otl/programs/peer_teaching)

   Week 14
Set your students up for success by holding office hours 
for additional study time for the final exam or, if students 
are completing projects, workshop time to consult with 
you and receive feedback. 

   Week 15
Avoid getting numerous emails from students by posting 
the timeline for posting grades for the final assessment 
and course. 

   Week 16
Even though it’s tempting to disconnect immediately 
after finishing up the class, take a few minutes to revise 
your syllabus for next time while everything is still fresh 
in your mind.

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl/faculty_resources/getting_started

PERFORMANCE 
OBJECTIVES 

What are instructional objectives? 
Also often referred to as learning objectives and 
performance objectives.

 » Instructional objectives are specific, measurable, 
short-term, observable student behaviors. 

 » An objective is a description of a performance 
you want learners to be able to exhibit before you 
consider them competent.

 » An objective describes an intended result of 
instruction, rather than the process of instruction 
itself.

Writing objectives for using Bloom’s 
Taxonomy and associated action or 
performance verbs.

Parts of a performance objective:    
Answer the question: “What should the students be able 
to do?”

Objective:  The students will be able to infer the 
developmental needs of a child by documenting evidence 
aligned with developmental theory.

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl

What should the students be able to do?

Learning Level Associated Action Verbs

Knowledge

define, describe, state, list, name, 
write, recall, recognize, label, 
underline, select, reproduce, 
outline, match

Comprehension

identify, justify, select, indicate, 
illustrate, represent, name, 
formulate, explain, judge, contrast, 
classify

Application
predict, select, assess, explain, 
choose, find, show, demonstrate, 
construct, compute, use, perform

Analysis

analyze, identify, conclude, 
differentiate, select, separate, 
compare, contrast, justify, resolve, 
break down, criticize

Evaluation

judge, evaluate, determine, 
recognize, support, defend, attack, 
criticize, identify, avoid, select, 
choose

Synthesis/
Create

combine, restate, summarize, 
precise, argue, discuss, organize, 
derive, select, relate, generalize, 
conclude

Sample Performance Objectives:
 » The students will be able to draw inferences about 
the causes of WWII.

 » The students will be able to identify the verbs in 
sentences.

 » The students will be able to explain the purpose of a 
given text.

 » The students will be able to apply the principles of 
design to a poster.

 » The students will be able to categorize rocks by type.
 » The students will be able to describe the habitats of 
various animals.

 » The students will be able to predict the outcome of 
habitat changes.

 » The students will be able to accurately measure wet 
and dry ingredients.

 » The students will be able to select the correct plant 
types to be grown in a particular environment.

The following are NOT observable or measurable 
performance objectives:

 » Appreciate the beauty of a circuit 
 » Understand relativity theory 
 » Be familiar with the law 
 » Understand the process of osmosis 
 » Enjoy speaking French
 » Learn about erosion
 » Listen to the lecture

The students 
will be 
able to

determine the 
development 
needs of a child

by documenting 
evidence 
aligned with 
developmental 
theory.

Audience:
Standard 
introduction 
for an 
objective.

Hint:  Focus on 
the students, not 
the teacher.

Behavior/Action 
Verb that is 
measurable and can 
be assessed.  What is 
the learner to do?

Content- description 
of the subject matter 
to be learned.

Hint:  Must specify 
observable and 
measurable behaviors.

Condition to 
be met by the 
students in order 
to demonstrate 
that the objective 
has been 
achieved.

Hint:  Describes the 
circumstances, situation 
or setting.

Adapted from resources found at:
www.bu.edu/cme/forms/RSS_forms/tips_for_writing_objectives.pdf
https://tips.uark.edu/using-blooms-taxonomy/

https://drive.google.com/file/d/1RmqzI9yZWTOz2mMqzwiE4K31LL-kcwrm/view
http://www.facebook.com/ndsuotl
https://drive.google.com/file/d/1RmqzI9yZWTOz2mMqzwiE4K31LL-kcwrm/view
https://www.ndsu.edu/gdc/qualtrics/student_rating_of_instruction_srois/
https://drive.google.com/file/d/1EYWHdHSzNE9PTvXbnxo19swOD3Yud69d/view
https://drive.google.com/file/d/1EYWHdHSzNE9PTvXbnxo19swOD3Yud69d/view
https://www.ndsu.edu/otl/programs/peer_teaching/
https://www.ndsu.edu/otl/programs/peer_teaching/


Example

The students will determine the developmental needs 
of children across all domains.

 » Student-centered—it states specifically what that 
students will be able to do.

 » It includes a measurable action verb
 » It identifies the content aligned with program goals.
 » Student friendly—it isn’t overly technical, and is 
easily understood by students.

A program goal/outcome from which this course 
objective is derived may look like:

 » Students will understand developmental domains.

WRITING 
COURSE 
OBJECTIVES

What are course objectives?
Course objectives directly state what the students 
will know or be able to do by the end of the course. 
They ensure the instructor and students have a clear 
path through the course. All learning experiences and 
assessments should align to the course objectives.

Course objectives are:
 » Specific
 » Concise
 » Student-centered
 » Measurable
 » Student-friendly
 » Aligned with program objectives/goals

What does a course objective look like?

How are course objectives different from 
individual session objectives?
The learning objectives for an individual course session 
are at a more granular level than an overall course 
objective and lead the student toward the corresponding 
course objective.

For example:
Course Objective— The students will determine the 
developmental needs of children across all domains.

 » Session Objective—The students will recall the 
developmental domains. (knowledge)

 » Session Objective—The students will list the 
common characteristics of the stages of cognitive 
development. (knowledge)

 » Session Objective—The students will recognize 
developmental delays. (evaluate)

 » Session Objective—The students will create a therapy 
plan for a child with developmental delays. (synthesis)

Learning Level Associated Action Verbs

Knowledge

define, describe, state, list, name, 
write, recall, recognize, label, 
underline, select, reproduce, 
outline, match

Comprehension

identify, justify, select, indicate, 
illustrate, represent, name, 
formulate, explain, judge, contrast, 
classify

Application
predict, select, assess, explain, 
choose, find, show, demonstrate, 
construct, compute, use, perform

Analysis

analyze, identify, conclude, 
differentiate, select, separate, 
compare, contrast, justify, resolve, 
break down, criticize

Evaluation

judge, evaluate, determine, 
recognize, support, defend, attack, 
criticize, identify, avoid, select, 
choose

Synthesis/
Create

combine, restate, summarize, 
precise, argue, discuss, organize, 
derive, select, relate, generalize, 
conclude

For more information or assistance, contact:
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Note: the action verb guides assessment. For example, 
knowledge-level learning can be measured through 
limited-response quizzes or tests; while higher level 
learning can be measured with constructed response 
and projects.

Bloom’s Taxonomy
Although there are several taxonomies for learning, 
Bloom’s is the most widely known and used. Bloom’s 
Taxonomy serves as a useful resource for identifying 
the action verb needed for writing effective objectives. 
The following chart provides the six learning levels and 
examples of aligned performance verbs.

TIPS FOR 
FILMING 
VIDEOS

Whether you are filming a lecture for your class or a 
video for YouTube, there are some strategies you can use 
to ensure your video is of good quality. A video of good 
quality makes it easier for the viewer to receive your 
message. 

Here are a few tips to ensure your video is of good quality.

Plan your video in advance
Planning your video in advance provides numerous 
advantages in terms of quality. The most important 
reason is that it decreases the amount of time spent 
filming and editing your video.  

Follow a script
Write a script before recording, the script entails what 
you will talk about in the video. The video needs to be 
short, concise and to the point. So, write your script 
keeping that in mind. 

Use good lighting
Preferably record In a shady area that will give a softer 
light. Avoid overhead lighting because that will cause 
harsh shadows on the subject’s face. 

Use a clean background
An easy way to do this is to have a solid-colored 
background like a blank wall. If you do not have or do 
not want to use a clean background, be sure to check 
that background elements in the camera frame are 
representative of the message you want to send and are 
not distracting.

Film with minimal background noise
Depending on the microphone sensitivity, lots of times 
microphones will record random noises like a fan, traffic, 
or background conversations. Record in a place free 
from those background noises. 

Have good audio recording device
Borrow a microphone if needed and connect it to 
the camera. The Office of Teaching and Learning has 
microphones available to borrow.

Avoid shaky footage
It is not possible to have the camera handheld and 
not have shaky footage. It is best to use a tripod or set 
up a camera on a flat surface so your footage looks 
professional. The Office of Teaching and Learning has a 
tripod available to borrow. 

Record with the best quality
Minimum quality should be 1080 pixels (px) at 30 frames 
per second (fps). Check your camera or phone to ensure 
it is recording at these settings. If you are using a phone 
to record be sure you have it set up horizontally rather 
than vertically. 

Appear natural in front of the camera
Try to appear as natural as possible. Use open body 
language. Maintain good posture. Keep your shoulders 
relaxed. Avoid crossing your arms since this makes you 
look closed-off. 

Speak slower
Individuals have a tendency to speak faster when they 
are on camera or in front of a crowd. Before you begin 
speaking pause and remind yourself to speak slower and 
enunciate tricky words. 

Make sure to smile
A smile, especially at the beginning of the video, offers a 
sense of warmth and appears welcoming.

Look at the lens
Be sure to look at the lens of your camera or the general 
direction of the camera on your computer this is how your 
eyes will connect with your viewers eyes. If recording 
from your computer, it may help to tape a photo of a 
person near the lens. 

For more information or assistance, contact:
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GETTING OFF
TO A
GOOD START
Helping All Learners Feel Welcome

The learning environment sets the stage for learning. 
Here are a few ways to set up your learning environment 
to make your learners feel welcome and able to learn.

Comfortable Seating
Think of comfort broadly.
 » The seating should establish opportunities for 

students to see and be seen and feel like they belong 
in the classroom. 

 » Can the seating be arranged in a circle to all allow 
learners to see one another?

 » Another option is to arrange the seating around a 
table or put desks in pods to encourage discussion 
and collaboration.

 » Can you position yourself as the instructor in ways 
that allow you to be close to your learners, make eye 
contact, and see and hear them when you are talking 
and eliciting their ideas?

Look and Feel of the Room 
Unlike our K-12 educator colleagues, higher education 
instructors typically don’t have their own classroom 
that can be customized to have a warm or personalized 
look and feel. However, there are things we can do to 
personalize the space we use. 

For example:
 » You can project an image and/or message that 

students see when they enter the room.
 » You can add a message to the whiteboard, welcoming 

students and/or giving them something to think 
about related to the day’s learning.

 » Another idea is to create learner toolkits that can 
be housed in the classroom or brought with you to 
class that include items that support thinking and 
discussion such as a mini-whiteboard, discussion 
prompts, response cards (Yes, No, Need More 
Information), activity protocols, resource sheets like 
a conversion chart or glossary, etc. 

 » Finally, consider creating a personal introduction 
for your students and inviting them to do the same. 
For example, post a photo and brief welcome that 
includes a glimpse into your interests and hobbies.

Communication
Although Zoom and Teams meetings have made us more 
aware of the expressions on our faces and how the way 
we look may be perceived, educators are often under-
aware of their non-verbal communication and tone. Plan 
for intentionality.
 » Position yourself near your students and work the 

room, so you aren’t only interacting with the students 
in your “splash zone.”

 » Practice holding a warm, interested, and friendly 
expression on your face. 

 » Make eye contact with your students to show them 
you are listening and paying attention to them.

 » Don’t be afraid to make a mistake or admit you do not 
know something. Instead, share with the students 
how you corrected the mistake or how you will learn 
what you don’t know.

 » Finally, review your syllabus for messaging; perhaps 
even invite a colleague to review it, letting you 
know the tone they feel. Can you set high and 
clear expectations while maintaining a warm and 
approachable tone?

For more information or assistance, contact:

NDSU Office of Teaching and Learning
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GETTING OFF
TO A
GOOD START
Engaging Learners

Engagement is predictive of several positive academic 
and life outcomes including academic achievement, 
reduced drop-out rates, greater satisfaction with life, 
and a better overall sense of well-being. In fact, without 
opportunities for students to connect with learning in 
meaningful ways, they don’t learn. So, how can you make 
engagement more likely? 

Engagement by design is an intentional approach to 
planning built upon the principle that every student 
deserves a learning experience with high levels of 
engagement. 

Classroom Relationships  
Relationships are among students and the content, 
peers, and instructor. Students are more likely to form 
a relationship with content when they can see how it is 
relevant, interesting, and useful. Positive relationships 
with peers that support engagement and learning require 
time and structure. Structure includes establishing 
guidelines for interaction that include respectful speaking 
and listening and worthwhile activities. Roger and David 
Johnson are experts in the field of cooperative learning 
with excellent resources on structuring collaborative 
interactions. Trust is the foundation of forming a 
relationship with your students. Trust is fostered when 
students see you as competent, which includes both 
knowing what you’re talking about and delivering on 
your promises. Students also trust instructors more 
who provide the instruction and feedback they need to 
succeed. In addition, relationships can be fostered with 
your students through sharing appropriate but personal 
information such as a photo and brief welcome that 
includes a glimpse into your interests and hobbies and 
inviting them to do the same.

Learner Voice
This includes listening, learning, and leading. Learners 
need to be taught how to listen to one another and 
provided with the structure for listening that includes 
expectations and modeling of respect and active listening.  
After hearing the ideas and perspectives of others, 
learners should be given the opportunity to demonstrate 
that they heard and learned from that experience. Finally, 
learners need opportunities in class to take responsibility 
for their own and others’ learning—not just passively 
intake content from the educator.

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl

Student Value
Students need to feel like they belong along with being 
recognized, appreciated, and celebrated. Value is 
cultivated when student growth and accomplishment is 
recognized. Value is also furthered when a student knows 
others believe in them. Keep in mind that recognition can 
be private such as sincere and performance-anchored 
feedback on an assessment. Belief can be conveyed with 
statements that not only tell the student you believe in 
their abilities but also explain how you know this (e.g., “I 
know you can do this. You have the knowledge and skills 
needed to complete this project. Let’s review what you 
know…”)

Clear and Worthy Content
Thoughtfully examine the content included in your class.  
Is it all important? Can you provide a strong rationale if 
asked “Why do we need to know this?” Once the worthy 
content is established, determine how you will clearly 
inform learners what they are expected to learn and what 
the success criteria look like.

Challenging Learning Experiences
Learners need an opportunity to rise to the challenge of 
learning the worthy content. Identify complex questions 
and problems for learners to grapple with. Help learners 
see the relevance in the content and the connections 
across the discipline.

1. Fisher, D., Frey, N., Quaglia, R. J., Smith, D., & Lande, L. L. (2018). Engagement by design: 
Creating learning environments where students thrive. Corwin.

www.ndsu.edu/otl
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QUALTRICS
Managing Your Account

Qualtrics is a robust survey software available to all 
faculty, staff, and students. When you take full advantage 
of its features your survey creation is more efficient. 
This section offers a variety of tips for using Qualtrics 
efficiently. Here are some tips for managing your 
Qualtrics account. 

Register For Your FREE Account
All NDSU faculty, staff, and students have access to a 
FREE university sponsored Qualtrics account. 

Claim your account here:
https://ndstate.qualtrics.com

Change Your Time Zone
Be sure you have your Qualtrics account set to the 
correct time zone. NDSU is on Central Time. 

To set the time zone:
 » Find “My Account” on the right side with your initial.
 » Then find “Account settings.” 
 » Look for Time Zones. The default is Mountain Time.
 » Change this to the time zone you are in or Central 
Time for the time zone NDSU is in.

Customize Home Page
Customizing your home page allows you to quickly get 
to what you use most often. 

To customize your home page:
 » Click the gear icon under Welcome to XM.
 » You can turn on or off the Active Surveys and Your 
workflows summary.

Manage Notifications
 » Click the bell icon on the top right.
 » Click the three dots.
 » Notification Settings is where you can turn on 
or off Notification Channels (Email and Mobile 
Notifications), Notification Types (Collaboration, 
Recommendations, Surveys, and Workflows).

Delete Notifications
To delete notifications on your home screen that you are 
done with do the following. 

 » Hover over a notification you don’t need anymore.
 » You will see the three dots. 
 » Select “Remove notification.”

 

Create Folders to Organize Projects 
You can create folders to organize all of your survey 
projects and allow you to access them quickly.

To make folders:
 » Locate “+Create new folder” on the bottom left. 
 » Give the folder a name (folders show in alphabetical 
order). You can create folders within folders.

 » Drag and drop surveys into the appropriate folders.

Search all surveys by highlighting the Project and 
Programs folder or search within individual folders.

Identify The Owner Of Your Surveys
If you have surveys that are shared with you, you may 
need to know who the owner of each survey is. To find 
this out, go to the Projects Page. While you are on that 
page you will notice a gear on the right. Click the gear 
and there is Owner option check box. By checking that 
box a column will appear with the name of the owner of 
each survey listed.

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.gdc@ndsu.edu
www.ndsu.edu/gdc

QUALTRICS
The Basics

Here are some tips for ensuring your Qualtrics basic 
survey information is set-up correctly and accessible. 

Use Next & Submit Buttons 
The next and submit buttons are important for navigating 
through your survey and are also used for accessibility 
purposes. The default arrows are not descriptive and 
are difficult to navigate when using a screen reader. In 
addition, adding a “Submit” button allows survey takers 
to know that the survey is ending and the is their last 
chance to edit responses, if they choose. 

How to change the buttons to read next & submit:
 » Highlight a block by clicking on the whole block. 
 » Look to the left for “Format.” 
 » Then look for “Next/previous buttons” when you 
click the button a Next/Previous Button text box will 
pop up. 

 » In the text box, type “Next” (or “Submit” if this is the 
only block with no page breaks). Remember the 
block with the “Submit” button must not contain any 
page breaks. 

 » Go to each section of the survey and repeat the steps.

This section also allows you to set the text for a “Back” 
button, if you choose to allow survey takers to change 
their responses in a previous section. 

Use Survey Display Names
Screen readers need survey titles and display names 
in order for the survey to be clear to the survey taker. 
The default survey name is “Online Survey Software  |  
Qualtrics Survey Solutions,” which is not descriptive of 
your survey. 

To add the survey display name:  
 » Open your survey. 
 » Look for the survey options icon.  (Hint: if you need 
labels for the menu icons, click > at the bottom of the 
screen to enable them.) 

 » In the “General” tab, look for “Display name”. 
 » Enter the survey title in the text box.

You may also choose to edit the survey description while 
you are there.

Setting Your Survey Availability
You can choose to set the timeframe in which your 
survey is available for individuals to take it. To do this, 
start by opening your survey.  

 » Navigate to “Survey options” and “Responses“ tab. 
 » Scroll down to “Survey availability” and click “Set 
specific start and expiration date.” 

 » Click “Edit Survey Availability” 
 » Set the Start date and Start time.
 » Set the Expiration date and Expiration time. If you 
want the survey to end at midnight, set it to 11:59 
p.m. to ensure that it is accurate. 

The survey will not be available until the start date and 
time have passed in the time zone your account is set to. 

Copying and Pasting
To achieve a consistent look in your survey when you are 
copying and pasting text you will want to ensure the fonts 
are all the same and at the same size. This is easiest to do 
as you go rather than waiting until you have completed 
the entire survey. 

To do this:
 » Look for the “Rich Content Editor” in blue above the 
text box you are pasting the information into this 
gives you formatting options.

 » The “Remove Formatting” in blue removes all 
formatting for only that question. 

The strip formatting option is also available in the survey’s 
tools, but it applies to the entire survey, so if you use it, 
you will need to redo any special formatting in the survey.

For more information or assistance, contact:

NDSU Office of Teaching and Learning
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QUALTRICS
Advanced Survey Set Up

Here are some tips for intermediate and advanced users. 

Ensure A Survey Is Only Taken Once  
There are times when you may want to ensure individuals 
take your survey only one time. To do this:

 » Open your survey and navigate to survey options.  
 » Look for the “Security” tab. 
 » Turn on “Prevent multiple submissions” option.

In the Qualtrics panel, by default, the survey taker can 
only take your survey once, unless you change the 
settings in the compose email section.

To change the settings:
 » Click “Show Advance Options”
 » Change “Link Type” to “Multiple Completes” or 
“Anonymous.” 

Adding A PDF To A Question
There are times when adding a PDF to a question is useful 
to your survey takers. First, decide if you need a display 
logic or skip logic for the question. Then decide what 
kind of question type you are setting up.

To add the PDF:
 » Click into the question you want to add a PDF to.
 » Click “Rich Content Editor.”
 » Click on “More.” 
 » Click the page icon with the corner turned down. 
 » Upload a New File and choose your PDF file.
 » When you are finished uploading, create a link to the 
PDF by highlighting the link & clicking the chain icon. 

 » Click on the “Target tab” to make sure it is set to 
“New Window (_blank).” This will open the PDF in a 
browser window so you don’t lose the survey taker.

Adding A PDF To A Workflow  
Have the survey open and click “Workflows.“

 » Create a workflow
 » Under “Templates” select “Start a workflow when a 
survey response is received or updated” then click 
“Survey response.” 

 » Name the the workflow.
 » Click on the “+.” This is where you decide if you have 
a condition or not. 

 » Select “Task.”
 » Email
 » The “To” area can be piped from survey questions, 
leave “From” as is, be sure you put something in the 
subject line.  

 » The body of the email is where you will insert the PDF. 
 » Select a library the PDF is in or upload the PDF.

When you are finished there should be a PDF link in the 
body of the email.

Create A Loop & Merge Block 
Loop and merge is based on a question that requires a 
number entered as an answer. The numeric question 
would be on a separate block from the loop and merge. 
For instance, How many pets do you have? loop and 
merge questions would repeat based on the number 
you entered. If you answered 3 pets, it loops back to the 
question, What is your pet’s name?, two additional times.
 
To create a loop and merge:

 » Make your numeric question required.
 » Make another block with the questions you want to 
repeat.

 » Highlight the entire block and look to the left for 
Block behavior, similar to Loop & Merge.

 » Enable Loop & Merge.
 » Select the option “Loop” based on a question and 
select the question in which you want to base Loop 
& Merge on

 » Select Choice and Maximum Loops.
 » You can delete Field 2 if you don’t need more than 
Field 1. 

 » Save
 » You can pipe the Field 1 (Click where you want to put 
the Field 1 and then click on Rich Content Editor) by 
each question in the Loop & Merge. followed by {A} 
icon to pipe find Loop & Merge and Loop & Merge 
Fields. This will indicate which loop the question is 
on.

Have A Survey Redirect To Another Survey
If you are doing a drawing or collecting personal data 
after a survey, this is a good setup to keep everything 
anonymous.

 » On the first survey you will click the bottom Block 
that says “End of Survey.” 

 » To the left you will see “Messaging” and a drop down 
list.

 » Click “Redirect to URL.”
 » Paste a second survey link in the “Website URL” box.
 » Publish the first survey.

Recode The Values Of Choices
The default for the first choice in Qualtrics is 1. However, 
if you begin with a positive scale, you will want that value 
to be the highest. To do this:

 » Make sure the question is checked.
 » On the left select “Question behavior” & “Recode 
values.” 

 » Renumber the choices.

Create a Survey Key 
Survey keys are created to ensure questions are correctly 
coded. You also need to send this to the statistics 
department or anyone else who is assisting you with 
survey analysis. The document will show you blocks, skip 
logics, and display logics. The values are in parenthesis.

 » Keep your survey open.
 » Look for “Tools” menu.
 » Select “Import/export” and “Export survey.” 
 » Select “Export survey to Word.” Accept all defaults. 
 » Click “Export.”

Auto-Renumber Your Survey 
Once you’ve finished editing your survey you can auto-
renumber your questions. Here’s how:

 » Have your survey open. 
 » Look for the “Tools” menu. 
 » Select “Auto-number questions.”
 » Select “Sequential Numbering.”

Set Up A Pre And Post Survey 
With a pre and post survey you can compare the data 
without asking the respondent for a code, which means 
you must use the same Qualtrics panel/contacts.

Start with your pre survey and go to the survey flow: 
 » Click “Add a New Element Here.” 
 » Click “Embedded Data.”
 » Pick from the “Survey Metadata” drop down and 
scroll until you find “Recipient ID.” 

 » Add a New Field. 
 » Type “ID” in the first box and “Value” will be piped. 
Click on the down arrow to find “Insert Piped Text“ 
and look for “Embedded Data Field.” Type in the box 
RecipientID and click Insert.

 » Move the “Set Embedded Data” block to the top so it 
is the first thing in the survey flow. 

 » Apply the changes.
 » Repeat the steps for the post survey.

When it comes to “Distributions,” you must use the same 
Qualtrics Distributions email and panel for both surveys. 
If you check the “Anonymize responses” box, the survey 
remains anonymous, but you will see the ID in a column 
where you can compare the data.

Produce Survey Printouts
To produce a survey printout that accurately reflects 
what respondents view, do the following:

 » Have the survey open.
 » Look for “Tools” menu.
 » Select “Import/Export.” 
 » Select “Print Survey.”

Anonymize Responses  
The anonymize responses option doesn’t record the 
survey taker’s IP address, location data, or contact 
information. Once you turn on the Anonymize responses 
option, your respondents’ identifying information is 
hidden. If this setting is turned on before a response is 
recorded, that response’s identifying information is not 
retrievable. If this setting was turned on after a response 
was recorded, the response’s identifying information will 
be retrievable.
   
If you send the link through Qualtrics email you can still 
see who has responded to your survey by looking at the 
“Distributions email history” which is under the drop-
down arrow of your invite.

To turn on anonymize responses:
 » Have your survey open.
 » Go to “survey options.” 
 » Select the “Security tab.”
 » Scroll to the bottom. 
 » Turn on Anonymize responses.

How To Find More Help Documents
NDSU offers a wealth of help documents for the Qualtrics 
survey software. Here are several ways to get additional 
assistance:

 » Search the ITS Knowledge Base using “Qualtrics” as a 
search term. You will bring up dozens of articles with 
answers to common NDSU usage questions. Access 
the knowledge base at >> https://kb.ndsu.edu/

 » View the OTL YouTube channel for tutorial videos on 
Qualtrics features. Visit the YouTube channel at >> 
https://www.youtube.com/c/ndsuotl

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.gdc@ndsu.edu
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RETENTION
Ideas for Retaining Students

Ensuring students stay, move through a program of 
study, and receive their degree is the cornerstone of 
higher education. You, the instructor, play a pivotal role 
in student retention. What follows is a list of ways you 
can help retain students which was taken from our Idea 
Exchange session on Retention.

1. Tell students what you are grading and when they 
can expect their grades. 

2. Give assignments back before you grade the next 
assignment so students can use your feedback to 
improve on the next assignment.

3. Offer a one-minute paper on what students learned, 
what stood out, what didn’t make any sense, what 
questions do they still have. Then start the next class 
with that information. Student Course Experience 
survey results go up as a result.

4. Students are overwhelmed when coming into a large 
lecture. Find ways to connect with those students 
and build community to build a sense of cohesion 
and belonging. 

5. Make your students feel safe so they can focus on 
learning.

6. As a way for you to learn names, have students 
introduce themselves using a video on Flipgrid. 
They can also watch each other’s videos to build 
community.

7. Students don’t often know what office hours are. 
Offer class points for coming to office hours. This 
is an opportunity to engage in conversation and 
connect one-on-one in a large class. It also makes 
students feel more comfortable in attending future 
office hours.

8. Call your office hours, student hours or drop-in help 
hours so it is very clear to students what that means.

9. For office hours, sit in a less intimidating location like 
the coffeeshop in the union or some other location 
so students feel comfortable coming to visit.

10. If allowed, bring your favorite pet to your office to 
draw students to your office hours and lower their 
stress level.

11. Break down the norms of your campus or class. 
Don’t assume students know these norms. (e.g. what 
credits are, that there is a new semester with new 
classes, etc.)

12. Have students name why they are interested in going 
into the field they are and one thing they want you to 
know about them. Address this when they are settled 
in, around week three. 

13. Students don’t know what they don’t know. 
14. Tell students about resources that are available to 

them, then take them on a field trip to some of the 
key resources, so they know where to go. This instills 
confidence in seeking assistance.

15. Ask your students to tell something interesting about 
themselves and then ask about their interest.

16. Become more than just an instructor to your students 
by showing them something about yourself. (e.g. a 
photo of your pet)

17. Do an about me assignment that is not related to 
the content. Ask students to tell you more about 
themself. For example, have them tell you a fun fact, 
a boring fact, and a pet peeve. This will help you get 
to know your students more.

18. Have individuals in the workforce come speak with 
your students to keep them motivated to get to their 
career.

19. Remind students to take one step at a time to get 
through their degree program. They don’t need to 
know everything about their degree, they will be 
introduced to the items they need as they get to 
them. 

20. Help students work through a decision to switch 
majors. Make it okay to change because students 
often don’t know what a degree means in terms of 
a career at the time they choose a major. Help them 
understand the breadth of jobs available in their 
program.

21. Focus on students in a program minor because some 
of those skills are applicable across careers.

22. Think about how the things that frustrate you as 
an instructor would impact your students. Remind 
students to be patient in those frustrating situations. 
Also, try to identify ways to minimize those frustrations 
for your students.

23. Offer clear expectations for the assignments in your 
class. Create a rubric so that students know what to 
do. Clear expectations helps avoid frustrations.

24. Identify and work to fix hurdles for students in their 
specific program.

25. Recognize there is a level of growth that happens 
when a student first gets to campus.

26. Help students develop resiliency so they are able to 
deal with challenges when they come up.

27. The first few weeks of school are most important 
for ensuring students know the resources available 
& how to access them. This can contribute to their 
sense of belonging & their ability to work through 
any discomfort the student experience may present 
for them.

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl
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relationship to current employee, or veteran status, as applicable. Direct inquiries to Vice Provost, Title IX/ADA 
Coordinator, Old Main 201, (701) 231-7708, ndsu.eoaa@ndsu.edu.
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